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Before Getting Started

It may be difficult to identify the important points in some illustrations without a
color copy of this booklet.  You can print or read this booklet in color from
MicroImages’ Web site.  The Web site is also your source for the newest Getting
Started booklets on other topics.  You can download an installation guide, sample
data, and the latest version of TNTlite.

http://www.microimages.com

TNTsim3D™ for Windows provides you with the ultimate way to explore your
geospatial data: real-time, interactive, 3D viewing.  Use your joystick, keyboard,
or mouse to move over and around a simulated 3D landscape and view your
geospatial data from any vantage point.  Open different views of the landscape
and view different landscape textures.  You prepare data for use in TNTsim3D
with the Landscape Builder process in TNTmips®.  Each landscape file contains
texture raster objects precisely matched to a terrain raster; the texture raster layers
can include any visual combination of geospatial data.

Prerequisite Skills  TNTsim3D is easy to use even if you have no previous
experience with geospatial analysis software.  If you have used a flight simulator
software program and have a joystick, you are already familiar with moving through
a simulated 3D scene.  But even those without a joystick can use the keyboard to
easily control movement, speed, and attitude.

Sample Data  The exercises presented in this booklet use sample data distributed
with the TNT products.  If you do not have access to a TNT products CD, you
can download the data from MicroImages’ web site.  In particular, this booklet
uses sample files BIGPINE3.SIM and PALMYRA.SIM in the SIMDATA directory on the
TNT V6.7 products CD.  Many other sample landscape files are available for
download from  MicroImages’ web site.

More Documentation  This booklet is intended only as an introduction to the
features of TNTsim3D for Windows.  For information about creating Landscape
Files for use in TNTsim3D,  consult the Tutorial booklet entitled Building 3D
Landscapes.

TNTmips and TNTlite®  TNTmips comes in two versions: the professional ver-
sion and the free TNTlite version.  If you did not purchase the professional
version (which requires a software license key), TNTmips operates in TNTlite
mode, which limits object size and enables data sharing only with other copies of
TNTlite.  TNTsim3D is a free product that works identically with either TNTmips
or TNTlite, but it can be used only on Windows computers.

Randall B. Smith, Ph.D., 29 July 2002
©MicroImages, Inc., 2002
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� Copy the files in the
SIMDATA folder on the TNT
V6.7 products CD to
your local drive

Welcome to TNTsim3D
Most geospatial data that you work with is a selec-
tive representation of a complex three-dimensional
landscape, but flat maps and images frequently con-
vey little sense of the vertical dimension.  Contours
and relief shading can be included with the map data
for this purpose, but the ideal way to visualize the
true shape of your geospatial data is to combine the
data with an elevation model and “fly” over and
around a 3D scene, examining features from any van-
tage point in real time.

TNTsim3D for Windows provides this capability,
allowing you to move over 3D terrains using joy-
stick, keyboard, or mouse controls.  You can control
all aspects of the viewer orientation (attitude), height
above the surface, and speed.  Special visual effects
are also available, such as automatic texture smooth-
ing and atmospheric effects (fog / haze).

You create the data for TNTsim3D using the Land-
scape Builder process in TNTmips, which creates
terrain and texture raster objects that are specially
optimized for real-time interactive 3D rendering.
These objects are stored together in a Landscape
File, a specialized type of TNT Project File with the
file extension *.sim.

TNTsim3D is similar in many respects to flight simu-
lator software products.  It uses similar 3D rendering
principles and techniques and provides the same
real-time 3D movement.  But the purpose of flight
simulator software is to mimic the experience of flight,
including different weather conditions and the flight
characteristics of different types of aircraft; the back-
ground landscape is secondary.  The purpose of
TNTsim3D, on the other hand, is to allow you to
view your geospatial data as a landscape.  Its em-
phasis is on allowing you to move around and over
the simulated landscape in real time while maintain-
ing high-quality rendering of the landscape.

The exercises on pages 4-9
cover hardware and
software requirements,
launching TNTsim3D, and
configuring input device
controls.   Use of multiple
texture layers is covered on
pages 10-11.  Pages 12-15
discuss the tools for
keeping track of your flight
position and attitude.  The
use of different types of
additional view windows is
presented on pages 16-21.
Texture smoothing, fog, and
other special effects are
discussed on pages 21-23.
The final section (pages 24-
27) covers how to manage
the performance tradeoff
between terrain quality and
frame rate, use of vertical
exaggeration, and launching
an atlas from TNTsim3D.
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Launching TNTsim3D

STEPS
� launch TNTsim3D
� if a Select Graphics

System window opens,
select either DirectX or
OpenGL and click [OK]

TNTsim3D is installed
automatically when you
install TNTmips.  A shortcut
to the program is created in
the MicroImages \
TNTproducts folder shown
in the Windows Start menu.
You can launch TNTsim3D
from the Start menu, or
copy this shortcut to the
Windows desktop.  You can
also double-click on any
TNTsim3D landscape file to
launch the program and
load the data from that file.

Before running TNTsim3D, make sure that either
OpenGL v1.1 or Microsoft DirectX 8.0 (or a later ver-
sion) is installed in your Windows system.  OpenGL
is a cross-platform program library for 3D rendering
and 3D hardware acceleration.  Support for OpenGL
v1.1 is included with Windows98, NT 4.0, and later
versions of the Windows operation system.  DirectX
is a suite of Microsoft multimedia program libraries
that include Direct3D for 3D rendering and hard-
ware acceleration and DirectInput for configuring
motion controls for input devices (such as keyboard
and joystick).  The TNTsim3D page on the
MicroImages web site provides links to instructions
on how to determine what version of DirectX is in-
stalled and how to download and install updates.

If only DirectX or OpenGL is installed on your com-
puter, TNTsim3D opens directly using that graphics
system.  If both DirectX and OpenGL are installed,
before TNTsim3D opens you are presented with a
window asking you to select which graphics system
to use.  In principle, DirectX and OpenGL provide
similar capability and performance in 3D rendering.
Both systems can take advantage of any 3D render-
ing capabilities built into your display board to
accelerate performance, which means higher frame
rates and smoother movement.  However, some dis-

play boards and drivers may not
provide equal support for DirectX
and OpenGL, so one may perform
better than the other on your com-
puter.  You will need to experiment
to determine which system works
best for you.  For best performance,
make sure that you have the most
recent Windows-certified driver for
your video display board and fol-
low the manufacturer’s instructions
to adjust hardware acceleration set-
tings.

For information on and updates for the 3D
graphics libraries used by TNTsim3D, go to:

• www.opengl.org
• www.microsoft.com/directx
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STEPS
� choose Open from the

File menu
� navigate to the directory

into which you copied
the Landscape Files
(*.SIM) from the
TNTproducts 6.7 CD

� select BIGPINE3.SIM

� choose Wireframe from
the View menu

� repeat the previous step
to return to solid view

� select Options from the
View menu and
examine the Display
panel, then click [OK]

Loading a Landscape File
TNTsim3D opens by default with a single window
on your desktop.  The File menu is used to open a
Landscape File and to exit the program.  This menu
also shows the last four landscape files you have
used, providing easy loading of recently-used data.

When you open a landscape file, TNTsim3D reads
the terrain raster in the file and constructs a 3D model
of the terrain surface. The surface model is a mesh of
interlocking 3D triangles that provides an efficient
approximation of the terrain surface.  The first tex-
ture raster in the file is then draped over this surface
model.  To see the surface model alone, choose View
/ Wireframe; this menu option acts as a toggle be-
tween solid and wireframe view
modes.  The state you have set when
you exit the program is used by de-
fault when you next open it.

You can resize the TNTsim3D win-
dow by dragging any edge or corner,
or use the standard Windows maxi-
mize/restore button on the right side
of the window title bar.  Keep in mind,
though, that increasing the window
size puts a larger demand on video
memory and may reduce the speed
and smoothness of movement
through the simulation.  In some instances your at-
tempt to enlarge the window may exceed the amount
of available video memory.  TNTsim3D in that case
returns to the previous window size and displays an
error message explaining the problem.  DirectX ap-
pears to be more demanding of video memory than
OpenGL.  If both graphics systems are available on
your computer, you can switch between
them using the Graphics System menu on
the Display panel of the Options window.

wireframe view

solid view

You can switch between
DirectX and OpenGL on the
fly using the Graphics
System menu on the
Options / Display panel.
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First Flight: Using Keyboard Controls

Default input control
settings. If DirectX is
installed there are no
Num key assignments.

Although you may already have a joystick or other
flight control device installed on your computer, let’s
use the keyboard for your first flight, because a num-
ber of actions have been pre-assigned to specific
keys.  These default input control settings are shown
the first time that you open the TNTsim3D Controls
window.  You can keep this window open on your
desktop as a quick reference to the keyboard con-
trols while you try them out.

The keyboard controls allow you to move in various
directions through the scene, control forward and
backward speed, and change your viewing orienta-
tion (attitude).  The attitude controls use the same
motions that would apply to an aircraft: pitch, roll,
and turn.  If you are not familiar with these terms,

pitch affects the vertical angle in the direction of
flight, roll affects the angle of the wings relative
to the horizontal, and turn affects the heading
(the horizontal direction of flight).

The way in which you use a key on the key-
board depends upon which control is assigned
to it.  The general motion controls (Altitude Up/
Down, Forward/Backward, Slide Right/Left/Up/
Down, Pitch Up/Down, Roll Right/Left, Turn Left/
Right) move you at a specified speed (discussed
later) as long as the key is held down.  To move
forward without having to continue holding a
key down, use the Throttle Up Key, which in-
creases your speed by a fixed amount each time
it is pressed.  The Throttle Down key slows your
forward speed and, if you slow down to a stop,
moves you backward at increasing speed.  The

Throttle 0 key stops the motion begun by the other
Throttle keys, while Roll 0 levels the wings of the
virtual plane.  The Look Right/Left/Up/Down keys
direct your view in a particular direction as long as
they are held down.  The Altitude Lock key acts as
an on/off toggle for maintaining the current altitude.

STEPS
� choose Show Controls

from the View menu
� using the keyboard

motion controls shown,
experiment with moving
through the 3D scene

The normal view direction is
straight ahead in the
direction of flight.  Use the
Look Right/Left/Up/Down
keys to temporarily look in
other directions.
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STEPS
� from the View menu

select Options
� click on the Input tab
� if you have a Configure

DirectInput button at the
bottom of the panel,
press it

� click on the Keyboard
tab and edit the
keyboard controls if you
wish

� click [OK] on the
DirectInput window and
the Options window

TNTsim3D uses the DirectInput software compo-
nent of DirectX to allow you to configure the flight
controls for your keyboard or other input device.
You can reconfigure the controls while operating
the simulator in either DirectX or OpenGL, but
DirectX must be installed on your system in order
for you to do so.  (OpenGL does not provide an
input configuration utility.)  If you do not have
DirectX installed, there will be no DirectInput push
button on the Options window Input panel, and you
will be limited to using the default keyboard con-
trols.  If so, this would be a good time to download
and install the latest version of DirectX from
Microsoft (see page 4).

The DirectInput window has a tabbed
panel for a joystick or other game con-
troller (if one is installed in your
system), the keyboard, and the mouse.
The right side of the keyboard panel
lists the keys and the currently as-
signed action for each.  To change the
assignment for a key, click on its entry
in the list or press the key on the key-
board.  Either action highlights the
control entry and
shows a scrolling
list of available ac-
tions in the lower
left portion of the
panel.  To activate
the action list,
press Enter (or
double-click on
the control entry)
and select a new
action from the
scrolled list.

Configuring Input Controls

DirectInput control window
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Configuring a Joystick
STEPS
If you have a joystick or
other game controller, make
sure that it is:
� plugged into your

computer
� set up and calibrated in

Microsoft Windows

Then proceed to:
� press the Configure

DirectInput button on the
Options window Input
panel

� select the tabbed panel
for your controller

� configure the stick
(axis) controls and the
button controls

� close the DirectInput
and Options windows

� practice moving with the
joystick, supplemented
by keyboard controls as
needed

A joystick, yoke, or similar game controller gives
you more realisitic, intuitive control over your move-
ments in TNTsim3D.  The lowest-cost joysticks have
only two rotation axes, so you must change roll and
pitch (bank the plane) to make turns.  Higher-priced
(but still inexpensive) joysticks allow the stick to
twist, providing three axes of rotation and indepen-
dent control of turn, roll, and pitch.  They also have
a separate throttle control that can be operated with
your other hand, as well as a number of buttons that
can control other motions.

You can also use the mouse as a motion control, but
only in a very limited way.  The mouse is better used
to interact with the data in the TNTsim3D window,
as described later.

TNTsim3D allows simultaneous use of different in-
put devices.  So even if you have a joystick, you
may still want to use the keyboard to control some
actions.  For example, if your joystick does not have
a throttle control, you can use the throttle up, throttle
down, and throttle 0 controls on the keyboard to
control your speed.

Sample action
assignments that I
have set for the
3-axis joystick I
use at Micro-
Images.  I move
the stick forward
or back to change
pitch, side to side
to roll, and twist it
to turn.
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Setting Other Input Options
STEPS
� from the View menu

select Options
� click on the Input tab
� change the value in the

Speed Forward /
Backward field to 500

� turn on the Minimum
Height check box and
change the height value
to 400

� click [OK] on the Options
window

� use any controls to
move closer to the
terrain surface until you
reach the minimum
height you have set

Flight following the ups and downs
of terrain at minimum height of 400 m.

The Input panel on the Options window also pro-
vides other settings that affect your movement
through the simulation.  In the upper left part of the
panel are three linear speed settings: Up / Down,
Left / Right, and Forward / Backward.  All are ini-
tially set to the same velocity (in meters per second),
which is based on the areal dimensions of the land-
scape.  The default speed is computed to traverse
the maximum extent (height or width) of your land-
scape in 120 seconds.  Each of these linear speed
values sets the speed used by the associated mo-
tion control.  When you use the throttle controls to
increment speed, the Speed Forward / Backward
value sets an upper velocity limit.  You can change
any of these linear speeds to move
more quickly.  But keep in mind that at
faster speeds the scene changes rap-
idly, forcing TNTsim3D to read more
data more quickly, and the image in-
formation held in memory must be
updated more frequently.  Your move-
ments may become less smooth, and
you may see more transient rendering
artifacts.

The settings in the upper right part of
the panel control the angular speeds (in de-
grees per second) for pitch, roll, and turn.
The default values are independent of the
landscape characteristics, and any changes
you make are retained for use in later ses-
sions.  You can also set both minimum and
maximum height values, which are also re-
tained until reset.  Setting a minimum height
prevents you from flying through and then
under the terrain surface.  If you set the
same value for minimum and maximum
height, you can maintain a constant height
above the surface while flying in any direc-
tion.



page 10

Selecting Textures
STEPS
� click on the Texture

menu
� note the check mark

next to the LandsatTM
menu entry

� select COLORSHADE from
the Texture menu

� select DRG from the
Texture menu

A single Landscape File can include any number of
texture objects showing different aspects of the land-
scape.  For example, the BIGPINE3 file includes three
textures: a “natural color” pan-sharpened Landsat
Thematic Mapper image (LANDSATTM), a color
shaded relief texture (COLORSHADE), and a scanned
topographic map (DRG).  The available textures are
shown on the Texture menu in the TNTsim3D win-

dow.  The first texture written to the
Landscape File is the first menu entry (in
this case, the LANDSATTM texture) and is
automatically selected by default when you
open the Landscape File in TNTsim3D.

Using the Texture menu, you can select any
or all of the textures in the file for viewing.
Each entry on the Texture menu acts as a
toggle to turn the

cor respond ing
texture on or off.
A check mark is
shown next to the
entry for each se-
lected texture.  Under DirectX, textures are
rendered by TNTsim3D in the same order
as their menu listing.  With all textures in
the the BIGPINE3 file selected, for example,
texture LANDSATTM is rendered first and

DRG is rendered last.  (OpenGL renders
textures in the opposite order.)  In this
case each texture image covers the full
extent of the landscape, and each is ren-
dered directly over the terrain model, so
only the last texture is visible in the win-
dow.  To find out how to visualize
multiple textures simultaneously, pro-
ceed to the next page.

Keep the current settings and
proceed to the next page.
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Texture Offsets and Inset Textures
The Texture Offsets window lets you set a vertical
offset from the surface model for any texture.  You
can use these settings to create a stack of “floating”
textures, allowing you to see all textures for the same
area at the same time.  You can even fly through or in
between the floating textures.

STEPS
� select Offsets from the

Texture menu
� enter an offset value of

3000 for the LANDSATTM
texture

� enter an offset value of
1500 for the COLORSHADE

texture

� click [OK] on the Texture
Offsets window

� use the flight controls to
move beyond the edge
of the landscape, then
turn to look back toward
the center of the scene

The YM67 sample Land-
scape File includes a COLOR-
DOQ texture whose image
covers only the central part
of the landscape.

Floating
textures for
the BIGPINE3
Landscape File

Flying
between
floating
textures

If a texture is created from an image that covers only
part of the landscape area, the remaining parts of
that texture are transparent in TNTsim3D, allowing
an underlying texture to be visible.  You can thus
simultaneously view (without offsets) a high-reso-
lution (perhaps color) image texture that appears to
be “inset” into a lower resolution (perhaps grayscale)
texture covering a larger portion of the landscape
(see the illustration above right).
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Keeping Track of Where You Are
STEPS
� reopen the Texture

Offets window and
reset all offets to 0

� use the Texture menu to
deselect the COLORSHADE

and DRG textures
� select Readouts from

the View menu
� click on the Viewer tab

in the TNTsim3D
Readouts window

� note how the listed
values are updated as
you move through the
landscape

A simulation opens with a default viewer position
above the upper left corner of the scene, pointing
toward the scene center.  As you fly around, infor-
mation on your viewing position is shown on the
Viewer panel of the TNTsim3D Readouts window.
This panel shows your horizontal (x y) position (in
map coordinates if the simulation objects are
georeferenced), altitude above sea level and height
above the terrain surface (both in meters), and angles
in degrees for pitch, roll, and heading.  By monitor-
ing these dynamically updated readings as you
move through the landscape, you can easily keep

track of your position and attitude.

The TNTsim3D window always shows a for-
ward (pilot’s) view in the direction of flight.
You can use the movement controls to change
your direction of flight to bring any feature of
the landscape into the view.  But there are
also several shortcuts that let you instantly
change the viewer attitude.  You can reorient
toward any terrain feature in the view by plac-

ing the mouse cursor on the feature and pressing
the left mouse button; the feature is then centered
in the view.  If your flight leaves you pointed away
from the landscape, the Recenter option on the View
menu reorients the viewer toward the center of the
scene, while the Restore Initial Viewpoint option on
the same menu jumps the viewer back to the default
starting position and orientation.

(left-click)

� to redirect the view to a
particular feature in the
landscape, move the
mouse cursor to that
feature and press the
left mouse button

� select Recenter from the
View menu

� select Restore Initial
Viewpoint from the
View menu

Left-click in
the view to
reorient the
flight toward
a particular
landscape
feature.
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Using the Compass Graphic
STEPS
� from the Texture menu

select the COLORSHADE

texture
� choose Options from

the View menu and click
on the Extras tab

� if  the Show Compass
checkbox is not
checked, click in it to
turn it on

� notice how the
compass rotates as you
move through the
landscape

An optional compass graphic in the lower right cor-
ner of the TNTsim3D window provides an additional
aid to 3D navigation.  This graphic, which is turned
on by default, is controlled by settings on the Extras
panel of the Options window.

The compass graphic consists of a central sphere,
arrows that point in the four cardinal directions
(north, east, south, and west), and arrows for the
four intermediate directions (northwest and so on).
The north arrow, other cardinal arrows, and interme-
diate arrows are shown in separate colors.  (Color
controls let you change the arrow colors if you wish.)
If the landscape objects are georeferenced, the north
arrow points in the north direction; oth-
erwise it points parallel to the column
direction in the rasters.

The compass points are drawn to lie in
the horizontal plane, so the compass
image provides a visual cue to your at-
titude relative to the horizontal.  This
attitude information is enhanced by
shading effects on the points and cen-
tral sphere, which are illuminated from a
point above the compass and to the
north.

Enter a new Size value to change
the size of the compass graphic.

View nearly straight down View nearly horizontal Banked turn
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Find Surface Coordinates with the Mouse
As we have seen, knowing your viewing position in
the simulation is important. But TNTsim3D enables
you to view georeferenced spatial data, so you may
be more interested in finding the map coordinates
and surface elevation of particular locations on the
landscape surface.  With TNTsim3D you can use
the mouse to determine point coordinates for any
visible portion of the scene.

When you place the mouse over some point on the
scene in the TNTsim3D window, the program projects
a sight line from the viewer position through the
screen position of the cursor and on to the corre-

sponding position on the landscape
surface.  The horizontal (x y) map coordi-
nates of this position are reported as the
Mouse Location item on the Mouse panel
of the TNTsim3D Readouts window.  (If
the landscape objects are not
georeferenced, the line and column num-
bers of the corresponding terrain raster cell
are shown.)  The Mouse Elevation entry
shows the corresponding surface eleva-
tion, which is interpolated from the closest
terrain raster cells along the sight line.

The four Accuracy values give you estimates
of the positional accuracy limits for the mouse
cursor position.  Each of the four values is
measured from a screen pixel immediately ad-
jacent to the cursor’s screen location; the
reported value is the 3D distance between the
surface locations of the neighboring and cen-
ter screen pixel.  These values vary due to
differences in viewing angle and the direc-
tion and angle of surface slope.

STEPS
� use the Texture menu to

deselect the COLORSHADE

texture
� click on the Mouse tab in

the TNTsim3D Readouts
window

� move the mouse cursor
within the TNTsim3D
window

� note how the values on
the Mouse panel
continuously update

Mouse position readout for a
sample mouse cursor location.
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Terrain Information
STEPS
� click on the Terrain tab

on the TNTsim3D
Readouts window

� examine the values
listed on the panel

� click on the Projection
button

� from the System menu
box on the Coordinate
System / Projection
Parameters window,
select Latitude /
Longitude, then click
[OK]

� note that positions and
extents are now
reported in degrees of
Latitude / Longitude

� set the coordinate
system back to
Universal Transverse
Mercator

The Terrain panel provides general geographic in-
formation about the landscape, including its
geographic extents and minimum and maximum ter-
rain elevations.  The panel also reports the current
Terrain Quality and  Frame Rate values (discussed
on a later page entitled Terrain Quality and Frame
Rate).

The Projection button at the bottom of the TNTsim3D
Readouts window opens the Coordinate System /
Projection Parameters window.  The controls on the
upper part of this window allow you to select the
coordinate system and datum (and zone, projection,
and ellipsoid where appropriate) for the position and
extents values in all of the readout panels.  In the
BIGPINE3 landscape file, the stored georeference in-
formation is in Universal Transverse Mercator Zone
11 coordinates, but you can choose to report posi-
tions in Latitude / Longitude or any other available
coordinate system.

The controls on the lower part of the Coordi-
nate System / Projection Parameters window
let you select the units for all readouts of dis-
tance, elevation, angle, and velocity.  Any
unit changes you make here are also shown
automatically on the Input panel of the Op-

t i o n s
window.
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Directional View Windows
STEPS
� use the Window menu

to open Left, Right,
Rear, and Vertical
windows

� click the Texture
icon button on the
Rear window and
select COLORSHADE from
the menu

The main TNTsim3D window shows the pilot’s view
in the current direction of flight.  But to gain a wider
perspective on the landscape, you can open addi-
tional windows that provide views in other
predefined directions.  These selections are avail-
able from the Window menu.  You can also select
textures for viewing independently in each direc-
tional window using the Texture icon button.

The Left, Right, Rear, Down, and Up windows show
views that are oriented relative to the current atti-
tude of the viewer “aircraft”.  The Left and Right
windows look to either side of the flight path (paral-
lel to the wings), while the Rear window shows the
view backward along the flight line.  The Up and
Down windows show views perpendicular to the
wings and the direction of flight.  To illustrate this
attitude-dependence, fly a level course and roll 90
degrees to the left; the Left view shows a view of the
ground and the Right views shows nothing but sky
(background color).

The Vertical window works differently; its view di-
rection is absolute, not relative to the atttitude of
the viewer.  The Vertical window shows a vertical
view toward the surface (downward if the viewer is
above and upward if the viewer is below the sur-
face).

� fly through the 3D
landscape and note
how the views relate to
each other

� close all of the
directional view
windows you have
opened
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Map View Window
STEPS
� select Map View from

the Window menu
� from the Map View

window’s Texture
menu, select DRG

� press the
Options icon
button on the
Map View window

� in the Map Options
window, make sure that
the Locator option is set
to Viewer-Center

The optional Map View window provides you with
an easy way to keep track of your position visually,
along with graphic controls that let you quickly
change your viewing geometry.  This window pro-
vides an overhead view that does not vary in scale
as the viewer’s altitude above the terrain changes.
The Map View window opens at Full View (display-
ing the full geographic extents of the landscape),
but you can use the icon buttons at the top of the
window to zoom in or out (or return to Full View).
Once you have zoomed in, the Map View remains
centered on the ground position that is currently
directly beneath the viewer, except when you are
close to the edge of the landscape.

You can select any single texture layer in the Land-
scape File to display in the Map View.  A topographic
map texture is a natural choice, since it combines
labeled map information with a representation of the
terrain.  The texture shown in the Map View is ori-
ented by default with north at the top.  You can use
the Orientation setting in the Map Options window
to orient to the current flight direction instead (Viewer
radio button).  In this mode, the Map View image
reorients as the flight direction changes.

The texture detail shown in the
Map View varies automatically as
you change zoom levels.Full Zoom In Zoom Out

The Extents field shows the
approximate percentage of
the landscape area that is
visible in the Map View at
the current zoom level (100
percent equals full extents).
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Map View Locator Controls
STEPS
� use the flight controls to

move through the
landscape and note
how the locator graphic
updates to keep track of
your position

� click and drag on the
Viewer location graphic
and note how the view
updates in the main
TNTsim3D window

� click in the Map View
window at a location
away from the locator
graphic and note how
the View Center snaps
to that location

Map View with Arrow locator

The Map View window shows a locator graphic that
indicates the map position of the current viewer lo-
cation.  The form of the locator is set by your selection
in the Map Options window.  The Arrow graphic is a
simple arrowhead whose base is at the viewer posi-
tion and which points toward the current view center
of the main TNTsim3D window (center of the pilot’s
view). The Viewer-Center graphic indicates the viewer
position with a cross and an arrowhead pointing
north, and also marks the exact location of the view
center with an open circle; the viewer and view cen-
ter positions are connected by a dashed line.

With either locator graphic, you can use the left
mouse button to drag the viewer position indicator

to a new location within the Map View.  This ac-
tion changes the viewer position and heading,
but does not affect pitch or roll.  All open view
windows update automatically to reflect the new
position.

With either graphic, if you left-click with the mouse
away from the viewer position, the view center jumps
to that location.  You can also drag the view center
to a new position.  All open view windows again
update automatically.

Viewer-Center locator

View Center
location

Viewer
location

If the viewer is close to the
terrain in an area with
significant relief, hills or
ridges in the foreground
may move in or out of the
line of sight to the view
center as you move.  As a
result, you may see the
view center indicator jump
in or out along the line
connecting it to the viewer
location.
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Point-of-Interest Windows
There may be special locations (points-of-interest
or POI) in your simulated landscape that you want
to keep track of as you move through the scene.
The Point-Of-Interest option on the Window menu
creates a view that remains centered on a designated
POI as you fly, even if the POI is no longer visible in
the main TNTsim3D window.  When the Point-Of-
Interest control window opens, you can identify the
POI simply by left-clicking with the mouse at the
appropriate terrain position in any view window.
A Point-Of-Interest window then opens centered
on that location (as seen from the current viewer
location). You can designate up to eight POIs,
with each tracked in its own window.  Each POI is
shown by a differently-colored bar marker in all
windows.

STEPS
� choose Point-Of-Interest

from the Window menu
� use the mouse to left-

click on a distinctive
feature in the TNTsim3D
window or any other
open view

� click [OK] in the Point-
Of-Interest control
window

� repeat the above steps
if you want to add
additional points-of-

interest

With the Point-Of-Interest control window open, left-click
in any view window to designate the POI location and
open the associated Point-Of-Interest window.

Open as many Point-Of-Interest windows as you
need.  Different-colored markers allow you to keep
track of the POI locations in all windows.

Keep at least one Point-
Of-Interest window open
and proceed to the next
exercise

(left-click)
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Editing and Naming a Point-of-Interest
STEPS
� click on the Edit

icon button on
the Point-Of-Interest
window

� enter a name for the POI
in the Name field of the
Point-Of-Interest control
window

� with the control window
still open, drag the POI
marker in the main
window to adjust its
position

� click [OK] in the Point-
Of-Interest control
window

You can change the position of a POI only when its
Point-Of-Interest control window is open.  To re-
open this window, press the Edit icon button on the
Point-Of-Interest view window.  You can then use
any view window (including its Point-Of-Interest
window) to reposition the POI.  Simply drag the POI
marker to a new location with the mouse, or left-click
at the new location.  (If the Point-Of-Interest control
window is not open, these mouse actions simply
recenter the view window at the new location).  You
can also manually enter map coordinates in the con-
trol window to set the POI at a predetermined map
location.

Edit the Name field to enter a name for the POI.
This title of the Point-Of-Interest window
changes to this text when you click [OK] or
[Apply] on the control window.

Left-click or drag the POI
marker in any view window
to reposition the POI.

Keep the Point-Of-Interest view window open and proceed to the next exercise
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STEPS
� if  the TNTsim3D

Readouts window is not
open, select Readouts
from the View menu on
the TNTsim3D window

� click on the POI 1 tab to
view the readouts for
the Point-Of-Interest
window

� click on the Forward tab
to view the readouts for
the main view window

Window Readouts
The TNTsim3D Readouts window provides posi-
tional information about each open view, including
any Point-of-Interest views.  Each potential view is
represented by its own tabbed panel.  (The Forward
panel provides readouts for the main TNTsim3D view
window.)

Each window readout panel lists the map coordi-
nates and elevation for the view center position
along with the distance from the viewer to the view
center. Estimates of the positional accuracy of the
center coordinates are shown using the same sys-
tem as for mouse cursor position.  If the view center
moves outside the extents of the landscape, posi-
tion readouts are blank for that view.

Readouts are provided for
each open view window.

Readouts for the main
TNTsim3D window are
provided on the Forward
panel.

Readouts for any open Point-of-
Interest windows are provided on
the numbered POI panels.
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Background Color and Texture Smoothing
STEPS
� select Options from the

View menu and click on
the Effects tab

� left-click on the
Background Color color
sample button

� use the resulting Color
window to select a light
blue background color
and click [OK]

� if the Smooth Texture
checkbox on the Effects
panel is active (not
dimmed), turn it on

� click OK on the Options
window

unsmoothed smoothed

TNTsim3D window with new
background color and DirectX texture
smoothing enabled.  Magnified views
of boxed area are shown above with
and without texture smoothing.

The Effects panel of the Options window lets you
control a number of visual effects for your simula-
tions, including background color, fog, and texture
smoothing.  The Background Color control allows
you to pick the background color from a standard
palette or define one or more custom colors for use
as backgrounds.

The Smooth Texture option is available only when
you are using DirectX as the graphics rendering
system for TNTsim3D.  Smoothing has two major
advantages: it reduces the blocky appearance of fore-
ground texture cells viewed at close range, and it

reduces “sparkle” in the more
distant portions of the moving
image.  If you have a modern
graphics board with 3D accel-
eration, the smoothing is
performed by the graphics hard-
ware itself, so there is minimal
impact on frame rate.  (If your
board does not support hard-
ware smoothing, the DirectX
software performs the smooth-
ing, though more slowly).Turning on the Antialias option (only in DirectX)

enables TNTsim3D to use a feature of some
graphics cards that smoothes color edges in the
rendered screen image.
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Using Fog
STEPS
� select Options from the

View menu and click on
the Effects tab

� turn on the Fog check
box, accept the default
settings, and click [OK]

� note the change in
scene visibility

� reopen the Options
window Effects panel,
change the Start value
to 2000 and the End
value to 20000, then
click [OK]

� note the change in
scene visibility

� reopen the Options
window Effects panel
and change the Fog
method to Exponential
Two

� set the Density value to
7.0 and click [OK]

When you view a natural landscape, detail and color
become less distinct in more distant parts of the
scene because of the effects of water vapor and par-
ticulates in the atmosphere.  Haze is almost always
present to some extent, and fog is an extreme ex-
ample.

To add realism to a landscape in TNTsim3D, you can
simulate the reduction of visibility with distance by
using the Fog controls.  The fog effect is achieved
by blending texture colors with varying amounts of
a designated fog color.  The background color is the
default fog color, which lets the hazy or foggy ter-
rain blend naturally into the sky.  For special effects
you can turn off the Use Background Color check
box and use the Fog Color control to select any color
for the color blending.

Three methods are available to control the variation
in fog density with increasing distance from the
viewer.  In the Linear method, the Start value
defines the distance at which the fog effect
begins, the End value defines the distance
at which fog no longer increases, and the
variation is linear between these limits.
Since the start and end distances are in
meters, the same pair of
values will produce differ-
ing effects for landscapes
of different areal extents.

In the Exponential method fog increases ex-
ponentially with distance.  In the Exponential
Two method, fog increases exponentially
with the square of the distance.  In both
methods the Density parameter is a multi-
plier applied to the distance exponent.
Increasing the Density pa-
rameter makes the fog
thicken more rapidly with
increasing distance.

Fog: Linear

Fog: Exponential Two
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Terrain Quality and Frame Rate
STEPS
� turn on the Wireframe

view mode (View /
Wireframe)

� select Options from the
View menu

� click on the Terrain tab
� increase the Quality

setting to 90 and click
[OK], and note the
increased detail in the
wireframe

� reset the Quality
percentage to 75

To improve both quality and frame rate, try the following:
� shut down other programs to free computer resources for TNTsim3D
� make your TNTsim3D windows smaller
� make sure your graphics card’s 3D acceleration options are turned on
� get a graphics card with faster 3D acceleration and more video memory
� get more random access memory (RAM) for your computer

A new terrain model is built
for each frame using only
the visible part of the
terrain.  The level of terrain
detail varies spatially in
each frame:  more detail is
shown (by smaller terrain
triangles) in the foreground
and in areas of greater local
relief.  As you move
through the simulation, the
amount of detail for a
particular area may change,
but height values
are automatically
adjusted to
produce gradual
rather than
abrupt visual
changes in local
detail.  As a
result, you may
notice gradual
upward or
downward
movements of
portions of the
terrain as you fly.

As you use TNTsim3D, you will likely want to move
through each landscape smoothly and realistically
and at the same time see the maximum possible scene
detail.  But achieving these twin goals may exceed
the resources available on your computer, so you
may need to choose which of them is more impor-
tant to you for a particular simulation session.

You can make that choice in TNTsim3D by using the
settings on the Options window’s Terrain panel,
where a pair of radio buttons allow you to give pref-
erence to either quality or frame rate.  Quality refers
to the amount of detail in the surface model created
from the terrain raster in the landscape file.  Quality
is expressed numerically as a percentage; setting a
higher percentage produces a surface model that
shows more of the detail in the terrain raster.  Frame
rate is the number of times the scene is redrawn each
second.  A higher frame rate produces smoother,
more natural movement through the landscape.

If you choose the Quality preference, TNTsim3D uses
available resources to maintain your target terrain

quality and reduces the frame
rate if necessary.  If you choose
the Frame Rate preference, the
program instead attempts to
maintain your target frame rate
and lets the terrain quality vary
as needed.  The effects of
these selections depend
greatly on the hardware capa-
bilities of your computer; they
are more significant for newer,
faster computers and graphics
cards.
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Using Vertical Exaggeration
STEPS
� turn off the Wireframe

view mode (View /
Wireframe)

� in the main TNTsim3D
window, choose File /
Open

� navigate to the directory
into which you copied
the Landscape Files
(*.SIM) from the
TNTproducts 6.7 CD

� select the PALMYRA

Landscape File
� fly through landscape

and note the low relief
of the terrain

� select View / Options
� click on the Terrain tab
� enter 3 in the Vertical

Exaggeration field and
click [OK]

Simulations of low-relief areas can reveal more infor-
mation about relationships between map data and
the terrain if the vertical terrain scale is changed to
exaggerate the topographic relief.  The Terrain panel
on the Options window allows you to set a vertical
exaggeration value (default is 1.00) to rescale all of
the Z-values in the terrain model.

When you increase the Vertical Exaggeration value,
the viewer’s height above the surface is automati-
cally increased by the same factor to ensure that the
viewer remains above the rescaled surface.  How-
ever, coordinate readouts for mouse position and
view center points always report elevation values
from the original unscaled surface, regardless of the
vertical exaggeration that has been selected.

Palmyra landscape
with no vertical
exaggeration.  This
texture shows soil
map polygons
overlaid with partial
transparency over
a grayscale digital
orthophoto
quadrangle mosaic.

Same area with a
vertical exag-
geration factor of
3.  The association
of different soil
types with
topography is more
evident than in the
original scene.

NOTE:  The last vertical
exaggeration value you
set is retained until
reset.  Therefore,
remember to check this
field when you open a
new Landscape File to
make sure the current
value is appropriate for
the data.
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Launching an Atlas
TNTsim3D can be used in conjunction with TNTatlas
to freely distribute your geospatial data prepared in

TNTmips.  TNTsim3D provides a real-time,
interactive 3D view of the data, while
TNTatlas provides the ability to view differ-
ent combinations of the original data layers,
access to associated database information
through datatips or directly viewing tables,
and measurement tools.

You can prepare your data so that you can
launch one or more atlases while viewing their
related Landscape File in TNTsim3D.  To do
so, place the atlas startup files (*.atl) in the
same directory as the Landscape File.  When
you open the Landscape File in TNTsim3D,
the names of the available atlases appear on
the Atlas menu.  As you fly over the land-

scape and encounter a feature of interest, select the
name of the atlas, then click on the terrain at the
desired location in any TNTsim3D view.  The atlas
opens in TNTatlas showing the designated area at a
scale determined by the viewer’s current height
above the surface.

To reduce duplication
of data, the layouts in
your atlas can utilize
any of the raster
objects in the
Landscape File
(textures or the terrain
raster).

Entries on the Atlas menu in
TNTsim3D are created from
the names of the atlas
startup files (.atl) in the
same directory as the open
Landscape File, so be sure
to give your startup files
distinctive names.

You can also create
hyperlinks in an atlas
to automatically launch
TNTsim3D and open
the appropriate
Landscape File.
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Advanced Software for Geospatial Analysis

M icro Im a g es, In c .
11th Floor - Sharp Tower
206 South 13th Street
Lincoln, Nebraska  68508-2010  USA

Voice: (402) 477-9554 email: info@microimages.com
FAX: (402) 477-9559 internet: www.microimages.com

MicroImages, Inc. publishes a complete line of professional software for advanced geospatial
data visualization, analysis, and publishing.  Contact us or visit our web site for detailed prod-
uct information.

TNTmips TNTmips is a professional system for fully integrated GIS, image analysis, CAD,
TIN, desktop cartography, and geospatial database management.

TNTedit TNTedit provides interactive tools to create, georeference, and edit vector, image,
CAD, TIN, and relational database project materials in a wide variety of formats.

TNTview TNTview has the same powerful display features as TNTmips and is perfect for
those who do not need the technical processing and preparation features of TNTmips.

TNTatlas TNTatlas lets you publish and distribute your spatial project materials on CD-
ROM at low cost.  TNTatlas CDs can be used on any popular computing platform.

TNTserver TNTserver lets you publish TNTatlases on the Internet or on your intranet.
Navigate through geodata atlases with your web browser and the TNTclient Java applet.

TNTlite TNTlite is a free version of TNTmips for students and professionals with small
projects.  You can download TNTlite from MicroImages’ web site, or you can order
TNTlite on CD-ROM.
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